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AMBISONICS

• Ambisonics è un formato audio surround a sfera completa: 
oltre al piano orizzontale, copre le sorgenti sonore sopra e sotto 
l'ascoltatore.  

• A differenza di altri formati surround multicanale, i suoi canali 
di trasmissione non trasportano i segnali degli altoparlanti. Al 
contrario, contengono una rappresentazione indipendente da 
un altoparlante di un campo sonoro chiamato formato B, che 
viene quindi decodificato nella configurazione degli altoparlanti 
dell'ascoltatore. Questo ulteriore passaggio consente a chi 
utilizza questo formato di pensare in termini di direzione della 
sorgente piuttosto che di posizione degli altoparlanti e offre 
all'ascoltatore un notevole grado di flessibilità in termini di 
layout e numero di altoparlanti utilizzati per la riproduzione.



AMBISONICS (2)
• L’Ambisonics è stato sviluppato nel Regno Unito negli anni '70 sotto 

gli auspici della British National Research Development Corporation. 
• Nonostante le solide basi tecniche e molti vantaggi, l’Ambisonics non 

è stato fino a poco tempo un successo commerciale, e sopravvisse 
solo in applicazioni di nicchia e tra gli appassionati di registrazione. 

• Con la facile disponibilità di potenti elaborazioni di segnali digitali (al 
contrario dei costosi circuiti analogici soggetti a errori che dovevano 
essere utilizzati nei primi anni) e il successo dell'introduzione sul 
mercato dei sistemi audio surround home theater dagli anni '90, 
l'interesse per Ambisonics ingegneri di registrazione, sound designer, 
compositori, società di comunicazione, emittenti e ricercatori sono 
tornati e continuano ad aumentare. 

• L'Ambisonics può essere inteso come un'estensione tridimensionale 
dello stereo M / S



Tecnica M / S: stereofonia Mid / Side 

• Questa tecnica coincidente utilizza un microfono bidirezionale (con una 
figura di 8 pattern polare) rivolto lateralmente e un cardioide 
(generalmente una varietà di cardioide, sebbene Alan Blumlein descrisse 
l'uso di un trasduttore omnidirezionale nel suo brevetto originale) di 
fronte alla sorgente sonora. Le capsule sono impilate verticalmente e 
riunite il più vicino possibile, per minimizzare il filtraggio del pettine 
causato dalle differenze nel tempo di arrivo. 

• I canali sinistro e destro sono prodotti da una semplice matrice: Sinistra 
= Mid + Laterale, Destra = Mid-Side ("meno" significa che aggiungi il 
segnale laterale con la polarità invertita). Questa configurazione produce 
un segnale completamente mono-compatibile e, se i segnali Mid e Side 
sono registrati (piuttosto che la sinistra e la destra a matrice), la 
larghezza stereo (e con quella, la distanza percepita della sorgente 
sonora) può essere manipolata dopo che la registrazione ha avuto luogo.



Tecnica M / S: stereofonia Mid / Side (2) 

• La tecnica di registrazione Mid-Side, ossia Centrale-Laterale, è una 
interessante opzione per tutte le volte che non è ancora ben 
chiaro quale ruolo possa avere uno strumento nel missaggio in 
futuro e quanto spazio esso occuperà nel panorama stereo. 

• Anche se può sembrare molto complessa da implementare essa in 
realtà è molto semplice e veloce e permette di modificare il suono 
dopo la registrazione in sessione di editing. 

• Importante ricordare che la tecnica M/S comporta l’utilizzo di due 
microfoni in posizione coincidente, cioè con le capsule posizionate 
il più vicino possibile: il microfono centraleha un pattern di 
registrazione cardioide ma può anche essere monidirezionale; il 
secondo chiamato microfono laterale deve avere un pattern a 
figura di 8, cioè registrare dai due lati e non davanti a se.



Mid-Side Stereo Microphone Technique with Omni-directional Mid



Tecnica M / S: stereofonia Mid / Side (3) 

• I due microfoni devono essere posizionati non troppo vicino 
alla fonte del suono, allo strumento, ed in modo che le due 
capsule quasi si tocchino. Il centrale deve ‘guardare’ 
direttamente allo strumento, il laterale deve invece 
registrare fuori asse di 90% rispetto al centrale, cioè 
prendere il suono indirettamente dai lati. 

• Lo scopo di questa tecnica è di ottenere una registrazione 
stereofonica flessibile, in modo da scegliere durante il 
missaggio l’apertura stereofonica che si vuole. 

• L’effetto si ottiene grazie alla peculiarità del microfono a 
figura 8 che comporta la duplicazione della sua traccia audio 
ma con la sua fase invertita.



Tecnica M / S: stereofonia Mid / Side (4) 

• Così le 2 tracce originarie (Microfono centrale + Microfono laterale) 
sono in realtà 3 (Microfono centrale + Microfono laterale + Duplicato 
del segnale del Microfono laterale con fase invertita). 

• Le 2 tracce laterali si raggruppano quindi, cioè l’originale e la 
duplicata, in modo che i relativi volumi siano dipendenti, il loro 
posizionamento nello stereo avviene alle due estremità opposte, uno 
all’estrema destra ed uno all’estrema sinistra. 

• Il risultato finale consiste in una traccia stereo, originata dalla 
duplicazione ed inversione del microfono a figura 8, ed una traccia 
mono da posizionare con pan centrale, che è rimasta invariata. 

• A livello di missaggio rimane quindi la possibilità di decidere l’apertura 
del suono stereofonico in base all’utilizzo della traccia laterale: 
maggiore sarà la sua ampiezza, maggiore sarà l’effetto stereo.



AMBISONICS (3)

• L'Ambisonics può essere inteso come un'estensione 
tridimensionale dello stereo M / S (mid / side), aggiungendo 
ulteriori canali di differenza per altezza e profondità. Il set di segnali 
risultante è chiamato B-format. I suoi canali componenti sono 
etichettati 

• W 
W per la pressione sonora (la M in M / S), 

• X 
X per il gradiente di pressione sonora anteriore-minus-posteriore, 

• Y 
Y per sinistra-meno-destra (la S in M / S) e 

• Z 
Z per up-minus-down



AMBISONICS (4)

• L’Ambisonics è un metodo di registrazione e riproduzione 
dell'audio in surround a 360 gradi e, sebbene non sia 
esattamente una nuova invenzione, i recenti sviluppi nella 
codifica del software lo hanno reso molto più interessante. 

• Con la richiesta di suono in surround e con l'avvento dell'audio 
3D per film e piattaforme immersive come la realtà virtuale, 
l’Ambisonics è un'opzione che è diventata sempre più utile. 

• Nel modo più semplice, ciò che è noto come segnale surround 
B di primo ordine può essere generato sia mediante la 
manipolazione software di sorgenti mono o da un tipo speciale 
di microfono, utilizzando una matrice tetraedrica di quattro 
capsule quasi coincidenti.



Matrice tetraedrica del microfono Soundfield



AMBISONICS (5)

• Così il microfono della TSL S”Soundfield” emette un segnale di 
formato B, che fornisce un segnale a quattro canali, in cui i 
quattro canali sono indicati come W, X, Y e Z, dove W rappresenta 
il riferimento omnidirezionale, X rappresenta il fronte e il retro, Y 
rappresenta sinistra e destra e Z è uguale su e giù. (Questa è una 
semplificazione grossolana ai fini di questaintroduzione.) Questi 
microfoni avranno unità di controllo hardware che offrono 
all'utente opzioni in termini di guadagno e orientamento e 
filtraggio direzionale e sono nella fascia più alta del mercato. 

• The Soundfield SPS200 and the Core Sound TetraMic both output 
simple capsule feeds and need software (SurroundZone2 for the 
Soundfield and VVTetraVST for the Core Sound) to correctly 
matrix the capsule feeds into a B-Format signal.



AMBISONICS (5)

• Il segnale risultante a quattro canali può quindi essere codificato per 
l'output in molti modi, da una singola sorgente in array surround mono 
a un sistema di diffusione multi-speaker, con il vantaggio principale che 
una volta acquisita la registrazione iniziale, è possibile utilizzare la post-
elaborazione per variare parametri come il pan, lo zoom o per ruotare: 
qualcosa che non è esattamente semplice da ottenere con altri sistemi. 

• L’Ambisonics consente di transcodificare il materiale sorgente in 
formato B in una miriade di formati, utilizzando plugin gratuiti come 
quelli della Rode (https://www.pro-tools-expert.com/home-page/
2014/3/20/tsl-release-free-surroundzone2-plug-in-for-soundfield-
record.html=) o TLS.  

• Ci occuperemo comunque di lavorare con posizionamento virtuale 
delle sorgenti con altro software.



Wave field synthesis
• La Wave field synthesis (WFS) è una tecnica di rendering audio spaziale, 

caratterizzata dalla creazione di ambienti acustici virtuali. Produce fronti 
d'onda artificiali sintetizzati da un gran numero di altoparlanti pilotati 
individualmente.  

• In fisica, un fronte d'onda è il luogo dei punti caratterizzati dalla 
propagazione di posizioni di fase identica: la propagazione di un punto in 
1D, una curva in 2D o una superficie in 3D. [1] Per un'onda 
elettromagnetica, il fronte d'onda è rappresentato come una superficie di 
fase identica. 

• Nella WFS tali fronti d'onda sembrano provenire da un punto di partenza 
virtuale, la fonte virtuale o la fonte nozionale. Contrariamente alle tecniche 
di spazializzazione tradizionali come lo stereo o il surround, la localizzazione 
di sorgenti virtuali in WFS non dipende e non cambia secondo la posizione 
dell'ascoltatore.



Fondamenti fisici della Wave field 
synthesis

• La WFS si basa sul principio di Huygens-Fresnel, che afferma che 
qualsiasi fronte d'onda può essere considerato come una 
sovrapposizione di onde sferiche elementari. Pertanto, qualsiasi fronte 
d'onda può essere sintetizzato da tali onde elementari. In pratica, un 
computer controlla una vasta gamma di singoli altoparlanti e li aziona 
esattamente nel momento in cui il fronte d'onda virtuale desiderato lo 
attraverserebbe. 

• La procedura di base è stata sviluppata nel 1988 dal Professor A.J. 
Berkhout presso la Delft University of Technology. [1] La sua base 
matematica è l'integrale di Kirchhoff-Helmholtz. Afferma che la 
pressione sonora è completamente determinata all'interno di un volume 
privo di sorgenti, se la pressione sonora e la velocità sono determinate 
in tutti i punti sulla sua superficie. 

•



Olofonia

• Pertanto, qualsiasi campo sonoro può essere ricostruito, 
se la pressione sonora e la velocità acustica vengono 
ripristinate su tutti i punti della superficie del suo volume. 
Questo approccio è il principio alla base dell’olofonia. 

• L'olofonia è una tecnica di registrazione e riproduzione 
sonora eseguita tramite uno speciale microfono 
denominato olofono che permette di riprodurre un suono 
in modo simile a come viene percepito dall'apparato 
uditivo dell'uomo: il suono non si percepisce più sui 
padiglioni delle cuffie o nell'arco stereofonico classico, ma 
addirittura fuori dalla testa, quasi nelle esatte coordinate 
spaziali di registrazione.



Fondamenti fisici della Wave field 
synthesis (2)

• Per la riproduzione, l'intera superficie del volume dovrebbe essere coperta con 
diffusori ravvicinati, ognuno guidato individualmente con il proprio segnale. Inoltre, 
l'area di ascolto dovrebbe essere anecoica, al fine di evitare riflessioni sonore che 
violerebbero l'assunzione di volume senza fonte. In pratica, questo è difficilmente 
fattibile. Poiché la nostra percezione acustica è la più esatta sul piano orizzontale, gli 
approcci pratici generalmente riducono il problema a una linea, un cerchio o un 
rettangolo di altoparlanti orizzontali attorno all’ascoltatore. 

• L'origine del fronte d'onda sintetizzato può essere in qualsiasi punto sul piano 
orizzontale degli altoparlanti. Per le sorgenti dietro gli altoparlanti, l'array produrrà 
fronti d'onda convessi. Le fonti di fronte agli altoparlanti possono essere renderizzate 
da fronti d'onda concave che si concentrano nella sorgente virtuale e divergono di 
nuovo. Quindi la riproduzione all'interno del volume è incompleta - si rompe se 
l'ascoltatore si trova tra i diffusori e la fonte virtuale interna. L'origine rappresenta la 
sorgente acustica virtuale, che approssima una sorgente acustica nella stessa 
posizione. A differenza della riproduzione (stereo) convenzionale, la posizione 
percepita delle sorgenti virtuali è indipendente dalla posizione dell'ascoltatore che 
consente all'ascoltatore di muoversi o dare all'intera audience una percezione 
coerente della posizione della sorgente audio.





Software per la spazializzazione: 
WFSCollider

• GameOfLife WFSCollider is an adapted version of SuperCollider, the audio 
synthesis engine and programming language, for Wave Field Synthesis 
spatialization. 

• WFSCollider consists of an audio spatialization engine that places individual 
sound sources in space according to the principles of Wave Field Synthesis, 
and a comprehensive set of composition tools. WFSCollider functions as a full 
DAW (Digital Audio Workstation), with a timeline editor, effect chains and 
realtime live control.  

• The supercollider programming language, which forms the base of the 
program, also enables users to fully script and adapt the system to their 
liking. However, knowledge of SuperCollider is not required for normal use.  

• When installing the software on a (home) system without WFS it can run in 
various "preview" modes, so that projects can be developed away from an 
actual system.



Casa del Suono 
Sistemi di diffusione



Annello di 10 altoparlanti, spazio 
principale della Casa del Suono



Anneau de 10 HP

Illustration: ©Elia Bonomi, Aggiornamento dei sistemi di riproduzione sonora della Casa della Musica, final thesis 
Master In Sound Technology and Music Composition, Conservatory “A. Boito” and University of Parma. 
 

- Distribuzione irregolare degli 
altoparlanti 

- Sono utilizzati per i concerti, 
soprattutto nel caso di pezzi misti:



• ©2018, Elia Bonomi, Aggiornamento 

dei sistemi di riproduzione sonora 

della Casa della Musica 

• MASTER DI I LIVELLO 

TECNOLOGIE DEL SUONO E 

COMPOSIZIONE MUSICALE 



Annello di 10 altoparlanti

• Nel caso di brani ottofonici bisogna accoppiare 
alcuni altoparlanti per ottenere l’annello di 8.  

• Lo stesso criterio si applica ai brani 
quadrafonici. 

• Stereo: conveniente radoppiare gli altoparlanti 
frontali. 

• Tempo reale, musica  
• Ambisonics



• ©2018, Elia Bonomi, Aggiornamento dei sistemi di riproduzione sonora della Casa della Musica. MASTER DI I LIVELLO 

TECNOLOGIE DEL SUONO E COMPOSIZIONE MUSICALE 



Coordinate diffusori 
©2018, Elia Bonomi, Aggiornamento dei sistemi di riproduzione sonora della Casa della 

Musica  
MASTER DI I LIVELLO 



Utilizzo dell’anello in formato multicanale 
(simulazione ottofonia)



Lampadario



Lampadario 2

• Il lampadario sonoro è un sistema di diffusione e allo stesso tempo 
un'installazione audio che ha la forma di una calotta sferica sospesa 
a 4 metri di altezza sotto la cupola della Casa del Suono. 

• Dispone di 224 altoparlanti raggruppati in 64 gruppi alimentati da 
altrettanti canali audio.  

• Anteriormente il sistema era controllato da un elaboratore che 
utilizzava un software realizzato su piattaforma Linux appositamente 
per la casa del Suono, da un’interfaccia audio che ancora oggi 
consente di utilizzare 64 canali audio digitali in uscita, da 8 
convertitori digitale-analogico da 8 canali ciascuno e da altrettanti 
amplificatori a 8 canali, per un totale di 64 canali analogici finali. 

• In teoria dovrebbe già essere pronto per funzionare con il software 
WFSCollider… 

• Download: https://sourceforge.net/projects/wfscollider/



Sala Bianca



Sala Bianca
• La Sala bianca è uno spazio nato per ospitare il sistema di ultima 

generazione per la spazializzazione del suono denominato Wave 
Field Synthesis (WFS). Dispone di un sistema surround avanzato, 
guidato da un software apposito che permette di creare un campo 
sonoro in due dimensioni, sfruttando un anello formato da 189 
speakers disposti ad un metro e cinquanta centimetri di altezza 
lungo il perimetro della sala. Per i visitatori viene messa 
regolarmente a disposizione una dimostrazione delle potenzialità del 
sistema WFS attraverso un ampia gamma di ascolti: si passa da brani 
appositamente composti per la Sala bianca che per l’occasione si 
trasforma in un vero e proprio strumento musicale, a registrazioni di 
esecuzioni dal vivo che possono essere diffuse trasportando 
virtualmente i presenti in diversi luoghi d’ascolto (attualmente è 
possibile un ascolto comparativo di musiche eseguite al Teatro 
Farnese di Parma, nella Sala Concerti della Casa della Musica della 
stessa città, nella Cattedrale di York e riprodotte da un normale 
impianto di uso domestico), fino ad arrivare alla riproduzione 
spazializzata di semplici rumori ambientali.



Planimetria, Casa del Suono



WFSCollider
• The 2.2 version of WFSCollider for Mac is provided as a 

free download on our software library. The bundle id for 
WFSCollider for Mac is net.sourceforge.supercollider. 
The most popular version of the tool is 2.0. Our built-in 
antivirus scanned this Mac download and rated it as 
100% safe. 

• The most frequent installer filenames for the application 
are: wfscollider_2.0b6-1.dmg and WFSCollider 
2.0b6-1.dmg etc. WFSCollider for Mac is categorized as 
Audio & Video Tools. This free Mac app was originally 
developed by Game of Life Foundation. The latest 
installation package takes up 15.6 MB on disk. 

• WFSCollider - Wave Field Synthesis spatialization for 
SuperCollider.



WFSCollider
• WFSCollider pour Mac est développé à la Game of Life Foundation, 

en Hollande. Il est gratuit et Open Source. 
• WFSCollider = Wave Field Synthesis spatialization for SuperCollider. 

 
Comment travailler avec WFSCollider: 

• Reproduire différents types de sources dans l’espace 
• Coupler des sons aux positions et mouvements spatiaux 
• Composer des trajectoires 
• Le son diffusé sur ces sources peut être un fichier audio de 

base, mais WFSCollider offre également de nombreuses 
possibilités de traitement et de synthèse du son (cependant live 
électroniques peut être trop risqué dans un système de WFS.) 

• WFSCollider est une version adaptée de SuperCollider, le 
moteur de synthèse audio et langage de programmation pour la 
spatialisation en WFS.



WFSCollider
• Outre piloter le système de la Game Of Life, 

WFSCollider peut également être utilisé pour préparer 
vos projets à la maison, ou même pour composer des 
configurations d’HP, stéréo, quadriphoniques, ou 
octophoniques en utilisant les mêmes fonctionnalités et 
interfaces. C'est ce qu’ils appellent le mode «hors 
ligne», le mode par défaut dans lequel WFSCollider va 
démarrer. 

• Il est également possible de gérer pratiquement 
n'importe quelle configuration WFS. Il peut être 
configuré pour de nombreuses situations, simplement 
via le panneau de préférences. WFSCollider peut gérer 
les configurations à une seule matrice et les 
configurations complètes entourant le public. Aucune 
compétence de codage SuperCollider n'est requise.



WFSCollider (2)
• Avant de lancer WFSCollider -> Préférences audio, SR, 

etc. 
• Ouvrir WFSCollider (ouvrez l'application avec la touche 

Ctrl enfoncée et choisissez "Ouvrir" dans le menu 
contextuel.) 

• Fenêtre post: vous devriez voir plusieurs messages 
indiquant SR, la carte son et d’autres informations (la 
sortie dépend des interfaces audio que vous avez 
connectées à votre ordinateur et de la configuration 
dans AudioMidiSetup.) 

• Fenêtre WFS Servers: En bas à gauche, vous devriez voir 
un bouton vert et à côté, le texte wfs_master. Si oui, 
vous êtes maintenant prêt à travailler avec le 
programme:



WFSServers window

Soundfiles can be of almost any format except for mp3 and FLAC. See here for 
a complete list: http://www.mega-nerd.com/libsndfile/  

The sample rate of the system is 44.1KHz, so soundfiles with that sample rate 
will sound the best (although it will playback sound files of any sample rate 
correctly). 

• Régler les préférences (!!)



Éléments de base dans WFSCollider:
Objets et concepts de base: 

Score (Uscore) 

• Un score contient une ligne temporelle, le long de laquelle 
des événements peuvent être placés. Quand on jouet une 
score on peut démarrer et arrêter de jouer ces événements 
au bon moment. La partition peut être enregistrée et lue sous 
forme de fichier (extension .uscore). Le système peut ouvrir 
et jouer plusieurs partitions en même temps. Il existe 
également des moyens de manipuler la timeline tout en 
jouant. Les partitions ont une analogie avec ce que l’on 
appelle parfois “arrangement” dans d’autres logiciels de 
DAW. 

• Créer une nouvelle partition, sauver en créant un nouveau 
dossier qui devra contenir tous les fichiers relatifs au travail.



WFSCollider (2)
• How to work with WFSCollider: 
• - playing with the various source types 
• - coupling sounds to spatial positions and 

movements 
• - creating arrangements 
• - composing trajectories 
• - using live input and control 
• GameOfLife WFSCollider is an adapted version of 

SuperCollider, the audio synthesis engine and 
programming language, for Wave Field Synthesis 
spatialization.



Éléments de base dans WFSCollider (1)
Objets et concepts de base: 

Event (Uevent): 

• Les événements sont des objets à activer par un score. Ils 
peuvent également être activés individuellement (via le 
code du super-collecteur, via les messages OSC ou via le 
bouton ‘power’ de l’éditeur). Il existe actuellement trois 
types d'événements: les chaînes (UChain), les marqueurs 
(UMarker) et ... Scores (UScore). Oui, le score lui-même 
est également un événement et peut être placé sur la 
timeline d'un autre score. Dans ce cas, nous appelons cela 
un dossier. Les événements ont des couleurs distinctes 
dans l'éditeur, qui sont attribuées automatiquement mais 
peuvent également être modifiées par l’utilisateur.



Éléments de base dans WFSCollider (2)
Importer des sons dans la partition: 

• Charger un nouveau son (utiliser l’échantillon par défaut.) 
• Notez que Pause dans WFSCollider signifie autre chose 

que dans la plupart des logiciels DAW. Lorsque vous 
configurez un score pour le mettre en pause, seul le 
montage est mis en pause. Tous les événements qui ont 
déjà joué continueront à jouer. Si vous voulez vraiment 
arrêter tout son, utilisez le bouton d'arrêt à la place. 

• Double click dans l’événement placé dans la score (zone 
relative au son), expliquer les réglages relatifs aux 
paramètres fondamentaux (changer la couleur de ce-ci 
aussi.) 

• Chargé des autres sons, changer sa position dans l’espace.



Éléments de base dans WFSCollider (3):
Chain (Uchain) 1: 

• Une chaîne contient une série d'unités (U). Ensemble, 
ils forment une chaîne de traitement, où un son est 
généralement généré, traité et envoyé aux sorties du 
système. Via l'éditeur, l'utilisateur peut concevoir le 
chemin du signal et le contenu de la chaîne. Une chaîne 
est un environnement fermé. Les sons et les processus 
d'une chaîne ne peuvent pas interférer avec les sons 
d'une autre chaîne; plusieurs chaînes fonctionnent en 
parallèle les unes aux autres. Si vous voulez que les 
processus sonores interfèrent les uns avec les autres, 
tout doit se faire au sein d'une chaîne (plus de détails: 
manuel de WFSCollider, «Architecture parallèle».)



Éléments de base dans WFSCollider (4):
Chain (Uchain) 2: 

• La durée d’une chaîne peut être soit un temps fixé, soit 
«infinie» (inf). Lorsqu'une chaîne à durée fixe cesse 
automatiquement de jouer une fois sa durée écoulée, une 
chaîne inf. jouera indéfiniment jusqu'à ce qu'elle soit arrêtée 
par l’utilisateur. Si un score inclut une chaîne de durée infinie, la 
durée du score deviendra également infinie. Les chaînes infinies 
sont généralement utiles pour les performances en direct. 
Même si la durée d'une chaîne est définie sur infinie, cela ne 
signifie pas que toutes les unités de la chaîne produisent un son 
infini. Par exemple, si un fichier son est impliqué, il peut être 
nécessaire de le configurer en boucle pour qu'il soit également 
lu indéfiniment (pour activer une boucle, double-cliquez sur 
l'événement et cliquez sur le bouton de la boucle. Le même 
principe s'applique à inf. -> loop pour le son + inf.)



Éléments de base dans WFSCollider (4):
Chain (Uchain) 3: 

• La durée d’une chaîne peut être soit un temps fixé, soit 
«infinie» (inf). Lorsqu'une chaîne à durée fixe cesse 
automatiquement de jouer une fois sa durée écoulée, une 
chaîne inf. jouera indéfiniment jusqu'à ce qu'elle soit arrêtée 
par l’utilisateur. Si un score inclut une chaîne de durée infinie, la 
durée du score deviendra également infinie. Les chaînes infinies 
sont généralement utiles pour les performances en direct. 
Même si la durée d'une chaîne est définie sur infinie, cela ne 
signifie pas que toutes les unités de la chaîne produisent un son 
infini. Par exemple, si un fichier son est impliqué, il peut être 
nécessaire de le configurer en boucle pour qu'il soit également 
lu indéfiniment (pour activer une boucle, double-cliquez sur 
l'événement et cliquez sur le bouton de la boucle. Le même 
principe s'applique à inf. -> loop pour le son + inf.)



Éléments de base dans WFSCollider (5):
Unit (U): 

- Une unité est une entité de traitement unique. Les unités ne peuvent 
fonctionner que dans le cadre d'une chaîne. Le concept d’unité peut 
être comparé à celui d’un plug-in de logiciel audio numérique, à la fois 
instrument et effet. Mais aussi le module de sortie est une Unit dans 
WFSCollider. Par exemple, il peut y avoir une unité qui lit un fichier son 
dans une chaîne avec une unité qui crée une source WFS. Le signal 
sera acheminé de l'unité de fichier son à l'unité WFS à l'intérieur de la 
chaîne. S'il n'y avait aucune unité WFS (ou toute autre unité produisant 
du son), il n'y aurait pas de son; le son est généré mais n’atteint pas les 
sorties. Vice versa, s'il n'y aurait qu'une unité WFS mais pas de fichier 
son ou autre type d'unité génératrice de son dans la chaîne, il n'y aurait 
pas non plus de son. Ensuite, l’unité WFS ne produira que le silence. 

- L'Unit est la colonne vertébrale de la bibliothèque de l'Unit. Ils 
permettent aux utilisateurs d’avoir un contrôle total sur le flux du signal 
de manière modulaire et de suivre ce qui se passe, à la fois dans une 
représentation graphique intuitive et dans un environnement de codage 
tout aussi intuitif.



Unit (U)

ça c’est similaire 
à ce qui se passe 
dans l’Uevent 
dans notre 
score.



Éléments de base dans WFSCollider (6):
Udefs: 

- Les Udefs contiennent des définitions de ce qu'une unité peut (et va) faire. Chaque unité 
est basée sur l’un des Udefs disponibles. Les Udefs peuvent: 

générer du son 
faire des traitements du son 
envoyer les son aux sorties  

- Les Udefs spéciaux créent les moteurs de panoramique WFS plus complexes. 
- Les Udefs sont stockés sous forme de fichiers de code SuperCollider. 
- Les Udefs fournis avec WFSCollider se trouvent dans des dossiers nommés «UnitDefs», 

à l'intérieur des dossiers Unit Library et WFS Library (situés dans le dossier Resources 
du paquet d’applications WFSCollider/Resources/Plugins/Extensions/Unit-Lib). 

- Pour voir les Udefs actuellement chargés: menu View-> Udefs, d'où il y a des liens vers 
les fichiers de code 

- Les Udefs sont reconnus par leur nom (exact). 
- Le chargement d'un nouvel Udef remplacera tout Udef existant du même nom. Vous 

pouvez ajouter plus de fichiers Udefs en les codant et en les plaçant dans ces dossiers. 
Vous pouvez également les placer dans le même dossier qu'un fichier .uscore qui l’utilise. 

- Normalement, les Udefs déjà inclus en WFSCollider sont suffisants pour faire beaucoup 
de choses différentes dans WFSCollider.



Éléments de base dans WFSCollider (7):
Markers 

- Barre d'instruments dans l’uScore -> Il est mieux de dédier une 
piste aux marqueurs. 

- Placer le marqueur dans la piste spécifique. Changer le nom du 
marqueur. Faire deux exemples: marqueur préconfiguré et avec 
la fonction de autoPause activée. 



Éléments de base dans WFSCollider (8):
EQ (UGlobalEQ) 

- Un global equalizer est disponible et fonctionne sur toutes les sorties son. Il peut être édité dans la 
fenêtre EQ (menu View-> EQ). Il a un low shelf et high shelf filter et 3 bandes de pics. Il comprend 
également un paramètre de gain. Cet equalizer contient également le limiteur intégré du système et la 
suppression du DC offset. Ceux-ci ne peuvent pas être édités; Ils sont là pour protéger les haut-parleurs 
du système. Le limiteur est conçu comme une douce “clipper”, qui entre en action lorsque le niveau 
dépasse 12 dB au-dessus de 0. Cela entraînera une distorsion audible. Le limiteur est configuré derrière 
l'EQ, raison pour laquelle il existe un paramètre de gain dans l’EQ. 

Level (UGlobalGain) 

- Le curseur de niveau élevé situé à droite de l'écran correspond au niveau global. Il est appliqué à toutes 
les sorties du système. Le niveau nominal est 0dB. 

Bar/beat vs. time (TempoMap/BarMap) 

- La Unit Library dispose d'un système de correspondance de tempo et de signatures. L'utilisateur peut 
décider si le minutage du score doit être basé sur des secondes ou sur des temps / mesures dans un 
tempo donné. Il peut également y avoir des changements de tempo et de signature, qui sont stockés 
dans l'objet TempoMap et sauvegardés automatiquement avec la partition. Pour créer un tempo 
mapping:  

- 1) changer le mapping de “time" à “bar” 
- 2) cliquer sur “edit”: dans la colonne à gauche on peut ajouter des changements dans le numérateur de 

la mesure, dans la colonne à droite on peut ajouter des changements de métronome.



Éléments de base dans WFSCollider (9):
Dossiers / partitions imbriquées (Folders / nested Scores) 

- Sur la “timeline” d'une Score il peut y avoir des UChains et des UMarkers, mais il peut aussi y avoir des 
scores. C'est ce que nous appelons des "dossiers", ou scores imbriqués. Ils peuvent être créés à partir 
d'événements sélectionnés à l'aide du bouton 'Dossier' et décompactés avec le bouton unfold. Double-cliquer 
sur l'événement ouvrira le dossier et donnera accès à son contenu. Les dossiers permettent de regrouper des 
événements. déplacer un dossier sur la timeline déplacera tous les événements qu'il contient. Les objets de 
dossier fonctionnent comme des partitions complètement séparées, qui peuvent également être démarrées / 
arrêtées individuellement. En utilisant le bouton [^], vous ouvrez le dossier de partition dans une nouvelle 
fenêtre, ce qui vous permet de l'enregistrer en tant que partition séparée. Veuillez noter que les dossiers ont 
leur propre timeline et leur propre carte de tempo, indépendants de ceux de leur partition parente. 

Presets (PresetManager) 

- WFSCollider comporte un système de préréglage global, utilisé à divers endroits. Il existe des 
PresetManagers pour EQ, UChains, UMarkers, configurations de haut-parleurs WFS et options WFS. Cela 
fonctionne de la même manière partout. un préréglage peut être choisi dans un menu inversé en bas de la 
page. Cela modifie les paramètres des objets sur le préréglage stocké. Dans le cas d'UChains, il remplacera 
les unités de la chaîne par celles du préréglage. Les boutons fléchés situés à gauche du menu permettent à 
l'utilisateur de basculer entre le préréglage et le dernier état de l'objet avant l'application du préréglage. Les 
boutons + / - situés à droite peuvent supprimer ou ajouter des préréglages à la liste, en fonction de l'état 
actuel de l'objet. Si vous ajoutez un préréglage et lui donnez le même nom que l'un des préréglages qui s'y 
trouve déjà, il sera remplacé. Les boutons [read] et [write] permettent à l'utilisateur de sauvegarder la banque 
de presets actuelle dans un fichier ou de les relire à partir d'un fichier précédemment enregistré. Par défaut, 
PresetBank affiche un ensemble prédéfini de préréglages, montrant principalement des exemples de ce qui 
peut être fait, ou constituant des points de départ pour de nouveaux objets. 



Éléments de base dans WFSCollider (9):
Point (Point) 

Les objets “point” sont utilisés dans WFSCollider pour définir la position d'une source. Ils 
représentent l'emplacement d'une source ponctuelle, mais également l'emplacement et la 
direction d'une onde plane. L'espace bidimensionnel du système est représenté de la 
manière suivante: 

- axe des x (en mètres) de gauche à droite; négatif à positif 
- axe "y" (en mètres) de l'arrière vers l'avant; négatif à positif 
- avec une conversion polaire normale, un angle en radians de 0pi signifie tout droit, et de là 

les angles se déplacent dans le sens anti-horaire 
- dans l'interface graphique, nous utilisons également "deg_cw" comme unités d'angle; ils 

sont définis comme étant compris entre 0 et 360 degrés dans le sens des aiguilles d'une 
montre, 0 désignant l'avant droit.



Éléments de base dans WFSCollider (10):
Point (Point) 

Pour les ondes planes, le point défini correspond au point du plan le plus proche du centre 
de la pièce:



Éléments de base dans WFSCollider (11):
Sources statiques et dynamiques 

- Distinction entre sources statiques et dynamiques en WFSCollider. 
- Les sources statiques ne sont pas autorisées à se déplacer en temps réel, ça 

permet au système de travailler avec beaucoup plus de sources statiques 
(optimisation excellente.) Si on change la position d’une source pendant que le 
système est en train de jouer, il n’est pas possible d’écouter le changement (donc 
arrêter et redémarrer l’événement.) 

- Les sources dynamiques, par contre, peuvent bouger. Ils utilisent l'optimisation en 
temps réel, ce qui les rend assez efficaces, mais environ la moitié moins efficaces 
que les sources statiques. 

- La ‘wfsSource’ Unit est utilisée à la fois pour les sources dynamiques et statiques. 
Par défaut, l'Unit est statique. L’Unit devient dynamique lorsqu'un UMap est appliqué 
au paramètre ‘point’. Cette Umap peut être comprise dans les catégories ‘point’ et 
‘trajectoire’, ou encore une ‘expand’ (qui permet de connecter des UMaps 
individuelles aux positions x et y du point). Dès que l'UMap est retiré, le module 
redevient statique. 

- Quality modes: “good” et “better”. Le mode "better" nécessite un environ 1,5 fois plus 
de puissance de CPU. 



Éléments de base dans WFSCollider (12):
Modèle d'amplitude 

- Dans WFSCollider est utilisé un modèle d'amplitude unifié, légèrement différent de celui de la plupart des autres logiciels de rendu 
WFS. L'amplitude globale (niveau, volume) d'une source est calculée à partir de la distance de la source au centre de la pièce. Au 
centre de la pièce se trouve une zone que nous appelons «maxAmpRadius», où le niveau est toujours maximum (par rapport au gain 
de la source et au niveau global). En dehors de cette zone, le niveau baisse lorsque le nombre de dB par distance pouvant être défini 
par l'utilisateur est doublé. Dans les paramètres par défaut, maxAmpRadius est de 5 m et le décalage en dB est de -6 dB par 
doublement de la distance (ce qui correspond au décalage attendu dans un environnement anéchoïque). Toutefois, dans de nombreux 
cas, un paramètre de désactivation de -3 dB par doublement de la distance semblera plus naturel à nos oreilles. Pour les sources 
d’ondes planes, la valeur par défaut est 0 dB (parce que les ondes planes idéales ne perdent pas d’énergie sur la distance). 

Filtre de distance 
- WFSCollider propose un filtre pour émuler la distance dans le rendu de la  source “point”. Il implémente un filtre passe-bas unipolaire 

avec une fréquence de coupure liée à la distance de la source au centre de la pièce:



Éléments de base dans WFSCollider (14):
Path /Trajectory (WFSPath) 

Dans WFSCollider les sources peuvent suivre une certaine trajectoire spatiale. Celles-ci s'appellent WFSPaths. Les WFSPaths sont une 
collection de points, avec des temps de transition entre les différent points qui les composent. Ils contiennent des informations sur la 
manière dans laquelle les valeurs situées entre les points sont calculés.  Les WFSPaths peuvent être lus par des UMaps “trajectory”, qui 
peuvent être assignés à un paramètre relatif au point de l’Unit “WFSSource”. 

La durée d'un chemin n'est pas couplée à la durée d'un événement. Les WFSPaths peuvent également être mis en boucle, démarrés 
avec un décalage et lus à différentes vitesses. Il y a deux façons de stocker WFSPaths: 
- dans la partition 
- en tant que fichiers “raw data" (données brutes) séparés (extension .wfspath) 
- Pour enregistrer un WFSPath en tant que “raw data”, cliquez sur le bouton “write data" dans le “Chain editor” et spécifier un 

emplacement sur votre disque dur où le fichier doit être enregistré. Si vous enregistrez le fichier dans le même dossier que votre fichier 
de score, celui-ci sera automatiquement localisé à la prochaine ouverture de la uScore, même si l'ensemble du dossier est déplacé 
vers un autre place dans votre ordinateur ou dans une autre machine. Si vous ne ‘écrivez pas de données (“write data”), WFSPath 
sera alors sauvegardé dans le fichier relatif à la uScore. Le manuel de WFSCollider dit: “Notez que les WFSPaths contenant des 
fichiers “raw data” sont lus de manière plus fiable que ceux enregistrés dans la partition, car ils doivent être envoyés intégralement via 
le réseau à chaque lecture. Cela les rend vulnérables à la latence du réseau en raison d'une charge de trafic élevée et augmente 
également la latence du réseau pour d'autres événements en même temps. En général, il est recommandé d'utiliser la fonction "écrire 
des données”. Toutefois il m’est arrivé de ne pas arriver à lire correctement la uScore avec cette méthode, pour ça il est bien de laisser 
une copie de la uScore sans sauver les fichier des trajectoires en manière externe. 

- Les WFSPaths peuvent être éditées et conçues via l'éditeur de WFSPaths. Ouvrez la Uchain -> UMaps -> Trajectory -> Insérez 
Trajectory dans “Point” de WFSSource (dynamic point) -> double clic sur l’icône graphique de la trajectoire ou cliquez sur “edit”. 

WFS Position Tracker (WFSPositionTracker) 

- Views -> WFS Position Tracker. 
- Il s'agit d'un système de surveillance global pour toutes les sources WFS actives. 



Éléments de base dans WFSCollider (15):
WFS Speaker Configuration (WFSSpeakerConf) 

- Le WFSSpeakerConf conserve la configuration actuelle des haut-parleurs du système. 
Pour pouvoir effectuer un rendu WFS correct, WFSCollider doit connaître la position 
exacte de toutes les enceintes. Ceux-ci sont définis dans le WFSSpeakerConf: 
WFSCollider -> préférences. Pour plus d’informations consultez la documentation du 
logiciel (surtout sur ce qui regard la configuration pour systèmes de WFS)  

WFS Preview Mode (WFSLib.previewMode) 

- WFSCollider -> préférences 
- Défault: phones. 
- Si vous définissez le mode de prévisualisation sur «désactivé», cela signifie que 

WFSCollider ne sera pas en mode de prévisualisation, mais générera un rendu WFS 
réel, basé sur la configuration actuelle du haut-parleur WFS. 



Menu score (1)
Score 
Le score est comme une timeline dans un séquenceur ou une station de travail audio 
numérique 

- New 
- Open 
- Save (extension: .uscore, les fichiers son que vous utilisez doivent se trouver dans le même 

dossier que le fichier .uscore.) 
- Save as… 
- Export as audio file… (Exportez le score en tant que fichier .aiff, en fonction de previewMode, les 

paramètres du menu Préférences.) 
- Add Event (Sh-Opt-Cmd-A) 
- Add Marker 
- Edit (modifier un ou plusieurs événements sélectionnés.) (Opt-Cmd-I) 
- Delete (Supprimer un ou plusieurs événements sélectionnés.) (Opt-Cmd-R) 
- Copy (Sh-Opt-Cmd-C) 
- Paste (Sh-Opt-Cmd-P) 
- Select All (Opt-Cmd-A) 



Menu score (2)
Score 

- Select Similar (sélectionne les événements qui ont les mêmes Udefs dans le même ordre dans 
leurs chaînes. Ou qui sont autrement du même type.) 

- Sort events (Trier les événements dans le score actuel par leur “start time”. Cela signifie que les 
index des événements (les numéros indiqués dans chaque événement de l'éditeur de partition) 
seront réattribués en fonction de leur ordre sur la ligne de temps.) 

- Overlapping events to new tracks: les événements qui se chevauchent sont déplacés vers une 
piste vide. 

- Remove empty tracks. 
- Disable selected (Opt-Cmd-M): l'événement sélectionné sera désactivé. Désactiver est différent 

de “muter” (il n’est pas joué du tout par le score.) 
- Enable selected (Opt-Cmd-U) 
- Enable all 
- Activer sélectionné et désactiver tous les autres (Opt-Cmd-P) 
- Add Track 
- Remove Unused Tracks. 

Le menu session est sous construction encore… 



Interface graphique (GUI)
Server window 

Power button = démarrez le serveur -à partir de la version 3 SuperCollider a été divisé en 
deux composants: un serveur (scsynth) et un client (sclang). Ces composants communiquent 
via OSC (Open Sound Control)-. 

k = kill all servers 

sync (seulement dans le cas de synchronisation entre différents serveurs) 

Latency (définition de la latence de tous les serveurs) 

Post window 

Messages de SC et WFSCollider 
Menu Window -> Post Window to front (Cmd-\) 
Pour Effacer: Window > Clear Post Window (Sh-Cmd-C)  



Interface graphique (2)
Score window 
éléments d'interface en haut de la fenêtre 

- Sélectionnez un événement, cliquez sur “i” pour ouvrir la Chain window. 
- “ - “ = effacer un événement sélectionné. 
- “+” = si aucun événement n'est pas sélectionné, un nouvel événement par défaut sera ajouté. 

Si un ou plusieurs événements sont sélectionnés, ils seront dupliqués. 
- “flag” (‘drapeau’): nouveau marker.  
- “ [ “ = positionnez le curseur sur la ligne temporelle, sur l’événement ou événements qui 

devront être coupés, les événements seront coupés à gauche. 
- “ ] “ = similaire à l’intérieur mais il coup à la fin. 
- “ | “ = coupez dans la position du curseur  
- Flèche vers gauche: annuler la dernière modification 
- Flèche vers droite: refaire la dernière édition. 
- (-) (petit bouton moins) = effacer l'historique des annulations et des actions activer/désactiver. 

Utilisez ceci si votre ordinateur devient lent après de nombreuses modifications 
- “Haut-parleur” = tous les événements sélectionnés sont désactivés. Les événements 

désactivés seront ignorés pendant la lecture de la partition. 
- “Serrure” (‘lock’) = Verrouille ou déverrouille les startTimes des événements sélectionnés. 

Les événements ne peuvent pas être déplacés horizontalement si leur startTime est verrouillé.



Interface graphique (3)
Score window 
éléments d'interface en haut de la fenêtre 

- “Dossier” (‘folder’): sélectionnez un ou plusieurs fichiers pour les insérer dans 
une partition imbriquée. Pour aller dans le dossier, double-cliquez sur le dossier sur 
la piste. Une fois que vous êtes dans le dossier, vous voyez le nom du dossier et à 
côté de celui-ci une flèche qui pointe vers le haut. Vous pouvez imbriquer des 
dossiers dans des dossiers. 

- Unfold = déploie les éléments des dossiers sélectionnés, après avoir ouvert un 
dossier via un double clic, deux éléments graphiques supplémentaires apparaîtront:

- Nom du dossier = (clic), remonter d’un niveau dans la hiérarchie 
des dossiers. 

- flèche vers le haut-pointage: (clic), nouvelle partition avec le 
contenu du dossier s'ouvrira.



Interface graphique (4)
- “ Mixer “ = ouvre la fenêtre Mixer, où les niveaux peuvent être visualisés 

et modifiés (souvent donne des problèmes -crash!- :-(  ) 
- “Snap” = Lorsque vous déplacez un événement, il se déplace en étapes 

de la taille du paramètre dans le menu contextuel d’accrochage (pop-up 
menu.) Les paramètres disponibles sont les suivants: off, cf, 0.001, 0.01, 
0.1, 1/32, 1/16, 1/12, 1/8, 1/6, 1/5, 1/4, 1/3, 1/2 , et 1. «cf» désigne la taille 
du bloc échantillon / trame de contrôle (block size / control frame -128 
échantillons-) de WFSCollider, qui est la résolution de synchronisation 
réelle. Lorsque l’éditeur de partition est en mode “mesure" (‘bar mode’), 
ces valeurs correspondent à des fractions de la pulsation métronomique. 
En mode "temps", ce sont des fractions de secondes. Notez que les 
“fractions de temps” des événements ne seront pas arrondies à la valeur 
d’accrochage (the events will not be rounded off to the snap value), mais ils 
seront plutôt incrémentées ou décrémentées par montant instantané. Vous 
pouvez sélectionner un événement en le sectionnant et en utilisant les 
touches fléchées de votre clavier de l’ordinateur, la valeur d'accrochage est 
utilisée comme taille de pas.  

- Vous pouvez aussi déplacer un événement sélectionné en utilisant les 
touches fléchées ver le haut ou ver le bas, vers les pistes successives. 



Interface graphique (5)
- “Q” = Attention! Rien à voir avec un égaliseur! Quantifie les 

StartTimes des événements sélectionnés à la valeur d'accrochage. 
Si aucun événement n'est sélectionné, la ligne de position sera 
quantifiée à la place. 

“Mode”:  
- “all” = Vous pouvez déplacer, redimensionner et ajouter des “fades” à 

des événements. 
- “move” = Vous pouvez seulement déplacer des événements, vous 

ne pouvez pas redimensionner ou ajouter des fades à des 
événements. 

- “resize” = vous pouvez déplacer seulement des événements (si 
l’événement est apparement bloqué cliquez sur l’icône de la serrure.) 

- “fades” = il ne marche pas.



Interface graphique (6)
Score window 
éléments d'interface au bas de la fenêtre 

- “Play” 
- “Pause” (les fichiers son en cours de lecture ne sont pas arrêtés) 
- “Back” (|<) (Cliquez sur ce bouton pour ramener la position actuelle au 

début du score ou, s'il y a des marqueurs dans le score, à la position 
précédente. Si le score était en train de jouer lorsque vous appuyez sur ce 
bouton, il sera joué à partir de la nouvelle position.) 

- next (>|) (marqueur suivant ou fin de la “Score”) 
- loop (le point de boucle est la fin du dernier événement du score. Le point 

de départ de la boucle est le début du score. Ne faites pas l'événement trop 
court, sinon le score ne sera pas bouclé. 

- SMPTE timecode: affiche la position de lecture actuelle. En cliquant dessus 
et en vous déplaçant avec les touches de curseur gauche ou droite de votre 
clavier, vous pouvez entrer des chiffres et avec la touche Entrée ou Retour 
vous pouvez définir la position de lecture actuelle sur cette valeur.



Interface graphique (7)
- “time / bar”: déployez le “score” en seconds ou measures 

musicales. En “bar mode” (measure mode) un ensemble de 
commandes différent apparaît:

bar-map display: affiche la position de lecture en mesures / temps / divisions 
(1/1000). Chacun des valeurs peuvent être édités séparément, les touches 
fléchées gauche/droite permet de sauter entre eux. 

signature display: affiche la signature actuelle pour toute la partition. La 
signature par défaut est 4/4 pour toute la partition. Il peut y avoir des 
changements de signature. Cette zone affiche et édite la signature à la position 
actuelle du score. Il peut être édité en faisant glisser la souris (alt ou control drag 
pour changer le dénominateur), touches fléchées -> entrant de nouvelles 
signatures via le clavier.



Interface graphique (8)
- “Play” 
- “Pause” (les fichiers son en cours de lecture ne sont pas arrêtés) 
- “Back” (|<) (Cliquez sur ce bouton pour ramener la position actuelle 

au début du score ou, s'il y a des marqueurs dans le score, à la 
position précédente. Si le score était en train de jouer lorsque vous 
appuyez sur ce bouton, il sera joué à partir de la nouvelle position.) 

- next (>|) (marqueur suivant ou fin de la “Score”) 
- loop (le point de boucle est la fin du dernier événement du score. Le 

point de départ de la boucle est le début du score. Ne faites pas 
l'événement trop court, sinon le score ne sera pas bouclé. 

- SMPTE timecode: affiche la position de lecture actuelle. En cliquant 
dessus et en vous déplaçant avec les touches de curseur gauche ou 
droite de votre clavier, vous pouvez entrer des chiffres et avec la 
touche Entrée ou Retour vous pouvez définir la position de lecture 
actuelle sur cette valeur.



Interface graphique (9)
- tempo display: Affiche le tempo actuel en BPM. Le tempo par défaut est de 60 pour 

toute la partition, où 1 temps = 1 seconde. Il peut y avoir des changements de 
tempo. Cette zone affiche et édite le tempo à la position actuelle du score. Vous 
pouvez l'éditer en faisant glisser la souris, en utilisant les touches fléchées ou en 
entrant de nouvelles valeurs au clavier. L’icône ‘lock’ dans le coin supérieur droit 
active le mode de verrouillage du tempo (tempo-lock mode.) Dans ce mode les 
startTimes de tous les événements de la Score seront modifiés en fonction des 
changements apportés au tempo (ils vont garder sa position dans chaque mesure 
malgré les changements au métronome.) 

- edit:  ouvre la fenêtre TempoMap, pour éditer les changements de tempo et de 
signature dans la partition. 

- follow: lorsque cette option est activée, l'éditeur de partition effectue 
automatiquement un zoom avant sur la position de lecture actuelle (ça peut être 
pratique si on utilise le zoom, si on est pour exemple à la fin de la Score et on 
recommence du début le curseur se déplacera automatiquement jusqu’au début et 
“suivra” la lecture.)  

- update: lorsqu'il est activé, ceci indique la position de lecture actuelle dans la 
timeline pendant la lecture. 

- OSC: lorsque cette option est activée, vous pouvez contrôler le Score avec des 
messages OSC.



Interface graphique (10)
mouse 

- Shift-click sur des événements pour sélectionner plusieurs d’eux. 
- Click-drag on an empty part in the Score to select multiple Events.  
- Double-click on an empty part to sets the current play position.  
- Double-click on the Event to open the Chain window. 
- Double-click on a Folder event to open it’s score. 
- Cmd-drag: allows drag and drop of events to other score windows.  
- Alt-drag: copies an Event. 

Chain window 
éléments d'interface dans la barre d’outils 

tempo display: Affiche le tempo actuel en BPM. Le tempo par défaut est de 60 pour 
toute la partition, où 1 temps = 1 seconde. Il peut y avoir des changements de tempo. 
Cette zone affiche et édite le tempo à la position actuelle du score. Vous pouvez 
l'éditer en faisant glisser la souris, en utilisant les touches fléchées ou en entrant de 
nouvelles valeurs au clavier. L’icône ‘lock’ dans le coin supérieur droit active le mode 
de verrouillage du tempo (tempo-lock mode.) Dans ce mode les startTimes de tous 
les événements de la Score seront modifiés en fonction des changements apportés 
au tempo (ils vont garder sa position dans chaque mesure malgré les changements 
au métronome.)



Projet acousmatique (1)

• Session de base en mono, stéréo ou multicanal? 
• Il est possible de simuler un stéréo, une quadraphonie, 

une octophonie et n'importe quel nombre de canaux 
(toujours 2D, il n’y a pas des paramètres d’élévation),  
car dans la WFS ce qui compte ce n'est pas le nombre 
de HP, mais le positionnement virtuel de la source elle-
même. Le nombre de sources virtuelles peut donc 
dépasser presque tout système multicanal ordinaire. 

• Mono ou Stereo -> WFSCollider. 
• Compléter la session en manière pratique.



Progetto compositivo

Composizione acusmatica:  
- Sala Bianca 
- Sala Bianca + missaggi stereo e fino a 8/10 canali. 
- Lampadario + missaggi stereo e fino a 8/10 canali e 

stereo. 
- Lampadario + annello fino a 10 canali. 
- Sala Bianca + Lampadario + Annello di 10 

altoparlanti + Missaggi diversi.



Progetto compositivo acusmatico (1)

• Sessione di base in mono, stereo o 
multicanale? 

• Mono, stereo, quadrifonia, ottofonia, 10 canali, 
Ambisonics, WFS. 

• Mono o Stereo -> WFSCollider.



WFSCollider (2)
• How to work with WFSCollider: 
• - playing with the various source types 
• - coupling sounds to spatial positions and 

movements 
• - creating arrangements 
• - composing trajectories 
• - using live input and control 
• GameOfLife WFSCollider is an adapted version of 

SuperCollider, the audio synthesis engine and 
programming language, for Wave Field Synthesis 
spatialization.



Progetto compositivo

Composizione acusmatica:  
- Sala Bianca 
- Sala Bianca + missaggi stereo e fino a 8/10 canali. 
- Lampadario + missaggi stereo e fino a 8/10 canali e 

stereo. 
- Lampadario + annello fino a 10 canali. 
- Sala Bianca + Lampadario + Annello di 10 

altoparlanti + Missaggi diversi.



Progetto compositivo acusmatico (1)

• Sessione di base in mono, stereo o 
multicanale? 

• Mono, stereo, quadrifonia, ottofonia, 10 canali, 
Ambisonics, WFS. 

• Mono o Stereo -> WFSCollider.



Casa della Musica: Sala dei concerti

La Sala Concerti consta di uno spazio d’ascolto per 156 persone la cui diffusione sonora è realizzata 
da tre coppie di diffusori acustici posti ai lati della platea, tre diffusori acustici di maggior potenza 
collocati sopra il palco e un subwoofer mobile. 
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Ulteriori letture e Presets creati

• Consultare per maggiori dettagli: 
“CdM_elab_tecnico.pdf” 

• Preset con le misure della Stanza Bianca per 
WFSCollider: 
“stanza_bianca_preset_WFSCollider.Meta_WFSSpe
akerConf.presets” 

• Bisogna creare un preset per AIIRADecoder IEM 
Plug-in: “Anello_Casa_del 
Suono_AIIRADecoder.json”



Ulteriori questioni pratiche:

• Mostrare il patch creato da Guido Ponzini 
“Casa_del_Suono_diffusione_2019_no-
AMB.maxpat”, si trova in  
Patches_casa_del_suono 

• Mostrare 
“CasaDelSuono_DiffusioneSTUDENTI.maxpat”, 
nella cartella “DiffusioneSTUDENTI”



Ulteriori informazioni sulla Sala dei 
Concerti

• Per maggiori informazioni sulla Sala dei 
Concerti consultare: Bonomi, Elia, 
Aggiornamento dei sistemi di riproduzione 
sonora della Casa della Musica, MASTER DI I 
LIVELLO, TECNOLOGIE DEL SUONO E 
COMPOSIZIONE MUSICALE.


